
 

 

 

SAP
®
 Front End 6.40

 
 

 
 
Document Version 1.08 – October, 2005 

 

 

SAP NetWeaver 2004s  
Installation Guide  



 

SAP AG 
Neurottstraße 16 
69190 Walldorf 
Germany 
T +49/18 05/34 34 24 
F +49/18 05/34 34 20 
www.sap.com 

JAVA® is a registered trademark of Sun Microsystems, Inc.  © Copyright 2003 SAP AG. All rights reserved. 
  
No part of this publication may be reproduced or transmitted in any 
form or for any purpose without the express permission of SAP AG. 
The information contained herein may be changed without prior 
notice. 

J2EE™ is a registered trademark of Sun Microsystems, Inc. 
 
JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., 
used under license for technology invented and implemented by 
Netscape.   

Some software products marketed by SAP AG and its distributors 
contain proprietary software components of other software vendors. 

 
MarketSet and Enterprise Buyer are jointly owned trademarks of SAP 
AG and Commerce One.  

Microsoft®, WINDOWS®, NT®, EXCEL®, Word®, PowerPoint® and 
SQL Server® are registered trademarks of Microsoft Corporation. 

 
SAP, SAP Logo, R/2, R/3, mySAP, mySAP.com, xApps, mySAP 
Business Suite, and other SAP products and services mentioned herein 
as well as their respective logos are trademarks or registered 
trademarks of SAP AG in Germany and in several other countries all 
over the world. All other product and service names mentioned are the 
trademarks of their respective companies. 

 
IBM®, DB2®, DB2 Universal Database, OS/2®, Parallel Sysplex®, 
MVS/ESA, AIX®, S/390®, AS/400®, OS/390®, OS/400®, iSeries, 
pSeries, xSeries, zSeries, z/OS, AFP, Intelligent Miner, WebSphere®, 
Netfinity®, Tivoli®, Informix and Informix® Dynamic Server

TM
  are 

trademarks of IBM Corp. in USA and/or other countries.  
  

ORACLE® is a registered trademark of ORACLE Corporation. Disclaimer 
Some components of this product are based on Java™. Any code 
change in these components may cause unpredictable and severe 
malfunctions and is therefore expressively prohibited, as is any 
decompilation of these components.  

 
UNIX®, X/Open®, OSF/1®, and Motif ® are registered trademarks of 
the Open Group. 
 

 LINUX is a registered trademark of Linus Torvalds and others. 
Any Java™ Source Code delivered with this product is only to be used 
by SAP’s Support Services and may not be modified or altered in any 
way. 

 
Citrix®, the Citrix logo, ICA®, Program Neighborhood ®, MetaFrame®, 
WinFrame®, VideoFrame®, MultiWin® and other Citrix product names 
referenced herein are trademarks of Citrix Systems, Inc.  

  
HTML, DHTML, XML, XHTML are trademarks or registered 
trademarks of W3C®, World Wide Web Consortium, Massachusetts 
Institute of Technology.  

Documentation in the SAP Service Marketplace 
You can find this documentation at the following Internet address: 
service.sap.com/instguides

  
 
 



Terms for Included Open 
Source Software 
This SAP software contains also the third party open source software 
products listed below. Please note that for these third party products 
the following special  terms and conditions shall apply. 
 

 

SAP License Agreement for STLport  
SAP License Agreement for STLport 

between 
 

SAP Aktiengesellschaft 
Systems, Applications, Products in Data Processing 

Neurottstrasse 16 
69190 Walldorf 

Germany 
( hereinafter: SAP ) 

 
and 

 
you 

( hereinafter: Customer ) 
 
 
1. Subject Matter of the Agreement 

a. SAP grants Customer a non-exclusive, non-transferable, 
royalty-free license to use the STLport.org C++ library 
(STLport) and its documentation without fee. 

b. By downloading, using, or copying STLport or any portion 
thereof Customer agrees to abide by the intellectual property 
laws, and to all of the terms and conditions of this 
Agreement. 

c. The Customer may distribute binaries compiled with 
STLport (whether original or modified) without any 
royalties or restrictions. 

d. Customer shall maintain the following copyright and 
permission notices on STLport sources and its 
documentation unchanged: 
Copyright 2001 SAP AG 

e. The Customer may distribute original or modified STLport 
sources, provided that: 
• The conditions indicated in the above permission notice 

are met; 
• The following copyright notices are retained when 

present, and conditions provided in accompanying 
permission notices are met: 

 
Copyright 1994 Hewlett-Packard Company 
Copyright 1996,97 Silicon Graphics Computer 
Systems, Inc. 
Copyright 1997 Moscow Center for SPARC 
Technology. 
Copyright 1999,2000 Boris Fomitchev 
Copyright 2001 SAP AG 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. Hewlett-Packard Company 
makes no representations about the suitability of this 
software for any purpose. It is provided "as is" without 
express or implied warranty. 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. Silicon Graphics makes no 
representations about the suitability of this software for 
any purpose. It is provided "as is" without express or 
implied warranty. 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. Moscow Center for SPARC 



 

Technology makes no representations about the 
suitability of this software for any purpose. It is 
provided "as is" without express or implied warranty. 
 
Boris Fomitchev makes no representations about the 
suitability of this software for any purpose. This 
material is provided "as is", with absolutely no 
warranty expressed or implied. Any use is at your own 
risk. Permission to use or copy this software for any 
purpose is hereby granted without fee, provided the 
above notices are retained on all copies. Permission to 
modify the code and to distribute modified code is 
granted, provided the above notices are retained, and a 
notice that the code was modified is included with the 
above copyright notice. 
 
Permission to use, copy, modify, distribute and sell this 
software and its documentation for any purpose is 
hereby granted without fee, provided that the above 
copyright notice appear in all copies and that both that 
copyright notice and this permission notice appear in 
supporting documentation. SAP makes no 
representations about the suitability of this software for 
any purpose. It is provided with a limited warranty and 
liability as set forth in the License Agreement 
distributed with this copy. SAP offers this liability and 
warranty obligations only towards its customers and 
only referring to its modifications. 

 
2. Support and Maintenance 

SAP does not provide software maintenance for the STLport. 
Software maintenance of the STLport therefore shall be not 
included. 
All other services shall be charged according to the rates for 
services quoted in the SAP List of Prices and Conditions and 
shall be subject to a separate contract. 

3. Exclusion of warranty 
As the STLport is transferred to the Customer on a loan basis and 
free of charge, SAP cannot guarantee that the STLport is error-
free, without material defects or suitable for a specific application 
under third-party rights. Technical data, sales brochures, 
advertising text and quality descriptions produced by SAP do not 
indicate any assurance of particular attributes. 

4. Limited Liability 
a. Irrespective of the legal reasons, SAP shall only be liable for 

damage, including unauthorized operation, if this (i) can be 
compensated under the Product Liability Act or (ii) if caused 
due to gross negligence or intent by SAP or (iii) if based on 
the failure of a guaranteed attribute. 

b. If SAP is liable for gross negligence or intent caused by 
employees who are neither agents or managerial employees 
of SAP, the total liability for such damage and a maximum 
limit on the scope of any such damage shall depend on the 
extent to which its occurrence ought to have anticipated by 
SAP when concluding the contract, due to the circumstances 
known to it at that point in time representing a typical 
transfer of the software. 

c. In the case of Art. 4.2 above, SAP shall not be liable for 
indirect damage, consequential damage caused by a defect or 
lost profit. 

d. SAP and the Customer agree that the typical foreseeable 
extent of damage shall under no circumstances exceed EUR 
5,000. 

e. The Customer shall take adequate measures for the 
protection of data and programs, in particular by making 
backup copies at the minimum intervals recommended by 
SAP. SAP shall not be liable for the loss of data and its 
recovery, notwithstanding the other limitations of the present 
Art. 4 if this loss could have been avoided by observing this 
obligation. 

f. The exclusion or the limitation of claims in accordance with 
the present Art. 4 includes claims against employees or 
agents of SAP. 

 



 

Typographic Conventions Icons 
  
Type Style  Represents 

Example Text Words or characters that 
appear on the screen. These 
include field names, screen 
titles, pushbuttons as well as 
menu names, paths and 
options. 

Cross-references to other 
documentation 

Example text Emphasized words or phrases 
in body text, titles of graphics 
and tables 

EXAMPLE TEXT Names of elements in the 
system. These include report 
names, program names, 
transaction codes, table 
names, and individual key 
words of a programming 
language, when surrounded by 
body text, for example, 
SELECT and INCLUDE. 

Example text Screen output. This includes 
file and directory names and 
their paths, messages, names 
of variables and parameters, 
source code as well as names 
of installation, upgrade and 
database tools. 

Example text Exact user entry. These are 
words or characters that you 
enter in the system exactly as 
they appear in the 
documentation. 

<Example text> Variable user entry. Pointed 
brackets indicate that you 
replace these words and 
characters with appropriate 
entries. 

EXAMPLE TEXT Keys on the keyboard, for 
example, function keys (such 
as F2) or the Enter key. 

Icon Meaning 

 
Caution 

 
Example 

 
Note 

 
Recommendation 

 
Syntax 
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SAP Front End Installation Guide 
Purpose 
This documentation describes how to install and distribute the SAP front-end software on 
Windows platforms. 
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Part I Introduction 
Documentation in the SAP Service Marketplace 
You can find this documentation at the following address: 
http://service.sap.com/instguides

SAP Notes 
For the latest information on: 

• Hardware requirements, see SAP Note 26417 

• Supported front-end platforms, see SAP Note 66971 

• Delivery, see SAP Note 166130 

SAP GUIs 
The SAP GUI Family consists of: 

• SAP GUI for HTML 

• SAP GUI for the Java environment (SAP GUI for Java)  

• SAP GUI for the Windows environment (SAP GUI for Windows) 

SAP GUI for HTML is based on the Internet Transaction Server (ITS) and has been 
integrated into the SAP Web Application Server as of NetWeaver 04. The Internet 
Transaction Server needs to be installed on the server side. On the desktop, a suitable 
browser is sufficient. Since the SAP GUI for HTML does not need SAP software to be 
deployed on the client, this GUI is not covered here. 

SAP GUI for Java is a generic SAP GUI that covers a variety of platforms. It has the same 
look and feel as the windows version with the exception of the platform-specific window 
decoration.  

Installation of SAP GUI for Java is described in the documentation that can be found in the 
folder GUI/DOC in the substructure for Presentation CD2 on the NetWeaver Presentation 
DVD. The documentation can also be found at http://service.sap.com/sapgui-java in the 
Download Section. 

SAP GUI for HTML and SAP GUI for Java do not have all the capabilities of SAP GUI for 
Windows. For example, some applications require the SAP GUI for Windows. For more 
information, read the Master Guides for the relevant SAP products. 

For more information about the SAP GUI Family, see http://service.sap.com/sapgui

Platforms 
SAP GUI for Windows provides support for the most common Microsoft Windows platforms 
like Windows 2000, Windows XP and Windows 2003 Server, while SAP GUI for Java is 
supported on many platforms including Windows, Mac OS X, Linux and various Unix 
versions. For running SAP GUI for HTML, you need a standard web browser (Internet 
Explorer, Mozilla or Firefox) on either Windows, Linux or Mac OS X. For more information, go 
to the SAP Product Availability Matrix http://service.sap.com/pam. 

Upgrading and Patching 
The term “upgrade” is used to refer to the transition from one Release to another, for example 
from 6.20 to 6.40. The term “patch” refers to changes within a release to remove errors. In an 
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upgrade you should proceed exactly as for a new installation (upgrading SAP GUI for 
Windows is an exception). 

Installation of the SAP Online Documentation 
You can access the SAP online documentation from the front end. The installation of the SAP 
online documentation is described in the guide Installing the SAP Library. 
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Part II SAP GUI for the Windows 
Environment 
Platforms 
The SAP GUI for Windows can be installed on:  

• Windows 2000 

• Windows XP 

• Windows 2003 Server 

SAP Notes 
SAP Note 456905 lists SAP Notes relevant for the installation of SAP GUI for Windows. 

Benefits as of 6.20 
The installation process has the following new features: 

• The new installation software has a new user interface with wizards to make the 
installation process easier. 

• Services for local security handling are easy to configure. 

• Configuration of the installation can be started from the Windows Control Panel. 

• Updating the installation is easier. Installed components are updated without needing 
to be selected. 

• The installation is faster and more stable. One reason for this is offline registration of 
controls. 

• Components can be added or removed after the installation has been completed. 

• There is no need to reboot. 

• Reduced network usage (hence, network load) – by up to 65% – in the “Server-Based 
Local Installation” scenario. For more information, see SAP Note 707816. 

• Advanced administration features such as remote administration, or event based 
custom scripting using VBScript. 

Deployment Scenarios for SAP GUI for Windows  
SAP GUI for Windows should, in most cases, be installed from an installation server. This is 
called server-based installation. In this method, the administrator sets up an installation 
server from which the installation of the SAP front-end software on many different clients can 
be achieved efficiently. The figure below shows a typical configuration and summarizes the 
operating system requirements. 
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Installation Server
Installation files 
including 
sapadmin.exe &
netsetup.exe.

OS: server version 
of Windows 2000 
or XP

Administrator

Recommended OS: 
Windows XP or 
2000

Client

OS: any supported 
Windows version

Client

OS: any supported 
Windows version

Client

OS: any supported 
Windows version

netsetup.exe
sapadmin.exe

OS: Windows 2000 
or XP.

Distribution 
Service (DS)

DS can reside on 
the installation 
server or on a 
separate computer.

DS

 
Server-based installation is very flexible, and offers the following options for installing SAP 
GUI for Windows:  

• without user interaction (unattended) 

• with user interaction (attended) 

The SAP GUI for Windows deployment scenarios are : 

• Server-based local installation. All the installation files are copied from the server to the 
client during installation. 

• Server-based server-dependent installation. Most binary files reside on the server. 

• CD-based local installation. This is mainly for testing purposes or for stand-alone 
computers. The administrator takes the installation CD from PC to PC. 

Server-Based Installation 
We recommend using server-based installation when several workstations or more are 
involved. The installation process is easy to do. Server-based installation is flexible and 
makes maintenance easier, for example when patches are to be applied. 

Which components to be installed, on which workstations, depends on the types of user. 
Different types of user have different requirements. For example, an employee in the HR 
department would require different components than a software developer.  

The administrator groups various components together as packages relevant for certain types 
of employee. The administrator can specify which package particular users receive or else 
offer a variety of packages and allow the user to choose the most appropriate one. 

The hard disk requirement on the installation server is approximately 800 MB.  

The different types of server-based installation (local and server dependent) have different 
advantages and are described below in more detail. 

Server-Based Local Installation 
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With server-based local installation, the installation files are copied to the client. This has 
several advantages: 

• Provides best performance and reliability (after installation, no fileserver has to be up). 

• Makes the client independent of the installation server. 

• Runs faster because files are not loaded from the network. 

As administrator, you can configure your own installation packages with SAPAdmin on the 
installation server or use the pre-configured packages provided by SAP.  

You apply patches on the installation server and call SAPSetup on your client again to apply 
the patch on the client. Installation may be via the command line. You can carry out 
unattended installations and automatic patch deployment on the client. To do this you place 
the appropriate command line in the logon script of the client. The logon script is a program 
that is executed when you log on.  

Server-Based Server-Dependent Installation 
With server-based server-dependent installation, all the installation files, except System 
DLLs, remain on the server. Therefore the footprint on a client is minimal. The installation is 
also much faster. 

Server-dependent installation dramatically reduces maintenance: if the logon script contains 
the appropriate commands, patches need only be applied on the server for the clients to 
benefit from them automatically.  

A high performance LAN is desirable, as is load balancing and high availability of the 
fileservers. 

A disadvantage of this installation method is that greater network bandwidth is required 
because everything has to be passed via the network.  

You can use one of SAP’s pre-configured server-dependent installation packages or create 
your own using SAPAdmin. 

Local Installation from CD 
Local installation from CD is useful for installing the SAP GUI on single machines (for 
example, laptops) that are not connected to a Local Area Network (LAN). It can also be useful 
for test purposes. 

Local installation from CD has disadvantages. No deployment scenarios are available. When 
patches need to be applied, each workstation gets patched separately. 
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  SAP Front End Installation Guide 

1 Installing the Front-End Components 
Prerequisites 
You have used Note 26417 to check that all hardware and software requirements for the 
front-end workstations have been met. If you do not have access to SAP Service 
Marketplace, use the fax request form included in the software package. 

Remarks on Installation 
SAP GUI for Windows 6.40 is compatible with SAP products based on SAP Web Application 
Server 6.40/7.00 and all earlier releases of SAP Software that are still supported by SAP. 

SAP GUI for Windows uses the Microsoft Controls technology, which means that all controls 
must be registered locally. As a result, the system database contains an entry indicating 
where each control can be found. Since the system always registers the latest controls, only 
the most recently installed version of a control is available at any time. 

This means that on a single computer only one version of SAP GUI for Windows may be 
installed. During installation of a new SAP GUI release, any older SAP GUI release which is 
present on the computer is uninstalled. 

Installation 

Server-Based Installation 
The following describes a typical flow for server-based installation and maintenance.  
... 

1. Set up an installation server and, if necessary, the local security handling. See Setting 
Up an Installation Server. [Page 16] 

2. Define installation packages for different user groups. See Maintaining Installation 
Packages [Page 20]. 

3. If  the local security handling has been set up, test it. You can do this by logging on to a 
user PC with a user account without local administrator rights and running 
netsetup.exe. 

4. Distribute the packages using the logon scripts of the user PCs. See Installing 
Packages Using the Logon Script. [Page 28] 

5. Maintain the installation server by applying patches. See Patch Deployment. [Page 33] 

6. Upgrade the client computers when a new front-end release becomes available. See 
Upgrading the Front End [Page 29]. 

Local Installation from CD 
See Local Installation from CD [Page 31]. 

Help and Reporting Problems 
During the installation procedure, you can always use the online help. If you experience 
problems, you should check the installation [Page 39] and consult the log files [Page 40] 
before contacting support. When reporting problems, always send the log files as well. 
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2 Distributing the Front-End Components 
The Installation Server 
Before you can distribute the front-end components, you must set up an installation server. 
After installation, this server contains: 

• Installation programs 

• Configuration information (for example, for packages) 

• Service files (for example, for local security handling) 

• The front-end components to be installed 

For a detailed description on how to proceed, see Setting Up an Installation Server. 

Installation Packages 
After the installation server is set up, you can create installation packages that users can run 
from the server. Users can install several packages, even if the packages share common 
components. 

Each installation package defines the components to be installed. Administrators may define 
whether package installations are server-based or local. For a detailed description on how to 
proceed, see Maintaining Installation Packages. 

Server-based Packages 
If there is a fast connection to the installation server that is not susceptible to downtime, we 
recommend server-based installations. This way, as many files as possible are stored on the 
server and executed from there. As a result, you save disk space and keep installation time to 
a minimum. 

Local Packages 
If your network connection is slow, we do not recommend server-based packages, since the 
number of accesses made to the server have a negative effect on performance. In this case, 
you should install locally.  

As a rule, we advise you to install locally whenever you are using many other front-end 
components, like R/3 add-ons, besides the SAP GUI. 

The Distribution Service and the Installation Service 
Windows 2000 and Windows XP have local security mechanisms. In these systems, only 
users with local administrator rights have write access to parts of the system database and 
the file system.  

SAPSetup provides a convenient solution to this problem through the Distribution Service 
(DS), which resides on the server, and the Installation Service (IS), which the DS installs on 
the client. The IS starts a new instance of sapsetup.exe that runs with sufficient privileges. 

14 06.10.2005 
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3   Planning Installation from Installation Server 
Before installing, you should consider the following points: 

• Which computer do you want to set up as an installation server? 

The computer you select for this purpose should be accessible for all users at any time, 
even after the installation is complete. This is required for maintenance purposes such 
as the distribution of patches. The network connection should allow high throughput. 
You need 800 MB of free disk space. The installation server should have a server 
version of Windows 2000 or Windows XP. 

• Which components are to be used by which user groups? 

You can create special installation packages for different user groups, who can then 
install only the components they actually need. Try to determine in advance which 
components are needed and which packages you need to create. You can predefine 
the destination folder for a package. 

Hard Disk Clones 
If the Windows 2000 or Windows XP operating systems were generated through hard disk 
clones on the user PCs, make sure that the domain is correct. To do this, take the computers 
out of the domain and then put them back in. 

06.10.2005 15 
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4 Setting Up an Installation Server 
Use 
If the front-end software is to be installed on a large number of computers in a network, you 
must set up an installation server first. When you do this, all files needed for installations from 
this server are copied into a shared directory on one computer. 

For very a large number of clients, you may want to set up several installation servers. You 
can use SAPAdmin to replicate from the first installation server. 

Prerequisites 
You need local administrator rights under Windows 2000 or Windows XP. 

Procedure 

Setting Up the First Installation Server 
... 

1. Create a folder for the installation and share it. You need to grant read-permission for 
the clients that will be using this installation server, and local administrator 
authorizations for the account that will be used by the Distribution Service. For example 
(under Windows XP, first deselect Use simple file sharing to see similar screens): 

... 

a. Right-click the folder. 

b. Choose Sharing... 

c. Select Share this folder 

d. Choose Permissions 

e. For the clients (Everyone), select Allow for Read, and deselect Allow for Change 
and Full Control. 

16 06.10.2005 
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f. Choose Add, and add the name of the account to be used by the Distribution 

Service. 

g. For Full Control, Change, and Read, select Allow. 

h. Choose OK. 

2. In folder Gui\Windows\Win32\SETUP in the substructure for the on the Presentation 
CD1 on the NetWeaver Presentation DVD, start admsetup.exe.  

The wizard appears. 

3. Choose Next.  

A dialog box appears. 

4. Enter the target folder to which the setup files are to be copied. This is the shared 
folder that you specified in step 1. 

06.10.2005 17 
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5. Choose Install to start the installation process. 

The installation process starts. All required files are copied to the installation server 
folder. Due to the volume of data involved, this process takes some time. When the 
installation process is finished, another wizard appears asking for two user accounts. 
This configures the Distribution Service. 

6. Enter the name and password of an administrator account that has local administrator 
authorizations on all the clients to which the front-end software will be distributed. For 
example, a domain administrator would satisfy these requirements. 

7. Choose Next. 

8. Enter the name and password of a domain user account and choose Finish. 

This account only requires read access to the installation server. It becomes a member 
of the local administrator group. 

Replication of the Installation Server 
... 

1. On the installation server, start SAPAdmin. 

2. In the left pane, expand the Servers node. 

3. Select the master installation server (if you click on the Master link, you will jump to the 
correct server).  

In the right pane, the options Replicate and Create Site appear. 
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4. If you want to create a copy of the master server, choose Create Site. 

If you have already created copies and the master server has since been patched, 
choose Replicate to update the copies. 

 
If additional servers were not created by the above procedure (but instead by 
admsetup.exe) and you want load to be distributed over the servers, you need to use 
Server → Load-Balancing to add the servers (the DS will then ensure that the local security 
handling of the servers allows the load balancing).  

06.10.2005 19 
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5 Maintaining Installation Packages 
After setting up an installation server, administrators can create installation packages for 
installation by users. The administrator uses SAPAdmin for this purpose. SAPAdmin can be 
found in the \SETUP folder on the installation server. 

Permissions 
If you do not want users to be able to install components (instead of predefined packages) 
from the installation server, the administrator must set up the permissions. The administrator 
needs to do this from a computer that has Windows 2000 or XP. The installation server must 
be running a server version of Windows (Windows 2000 (Advanced) Server or Windows 2003 
Server). 

Procedure 
... 

1. On the installation server, start SAPAdmin. 

2. Choose Server → Permissions... 

3. Deselect Install Components from Server. 

4. Choose OK. 
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5.1 Creating a New Installation Package 
Procedure 
... 

1. On the installation server, start SAPAdmin.  

2. Choose File → New Package. 

The Package Wizard starts. 

3. Enter a name for the package, then choose Next. 

4. Select the components to be included in the package, then choose Next. 

When you select a group or component, a short description with the disk space 
required is displayed on the right. A checked box is white if all the components 
underneath have been selected, but is gray if only some have been selected. If you 
select a component that requires other components, these are automatically selected 
as well. 

 
5. Select the type of installation for the package, then choose Finish. 

You can choose between local installation and server-dependent installation. For more 
information, see Server-Based Installation. 
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5.2 Modifying Installation Packages 
Procedure 
... 

1. On the installation server, start SAPAdmin.  

2. Select a package, and choose Edit → Package Content. 

The Package Wizard starts. 

3. Select or deselect components. 

When you select a group or component, a short description with the disk space 
required is displayed on the right. A checked box is white if all the components 
underneath have been selected, but is gray if only some have been selected. If you 
select a component that requires other components, these are automatically selected 
as well. 

4. Choose Finish. 

5. Choose File → Save. 
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5.3 Creating Files for use with SMS, Tivoli, and Others 
Use 
SAPSetup can be integrated with the Microsoft Systems Management Server (SMS), Tivili, 
and others, which means that you can start installation packages as SMS jobs. For this 
purpose, you can use SAPAdmin to generate a .PDF and an .SMS file for each installation 
package. 

Procedure 
... 

1. Select a package, and choose File → Export → Package Definition File... 

2. Enter a folder and name for the files, then choose Finish. 
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5.4 Event Scripting 
Using VBScript, you can modify the installation without having to alter the XML or XSC files 
supplied by SAP. Each installation package that you create contains three scripts that you 
can edit: 

• OnBeginInstall – is executed at the start of the installation 

• OnEndInstall – is executed at the end of the installation 

• OnUninstall – is executed before the package is uninstalled 

 
You should be an experienced VBScript programmer before you use this possibility. 

 

Procedure 
... 

1. On the installation server, start SAPAdmin. 

2. Under the node of the package that you want to modify, select the relevant script name. 

3. The editor opens in the right pane. 

4. Enter your VBScript code. 

Some Scripting Possibilities 
To copy a file:

Engine.Shell.CopyFile "<full path to source file>", "<full path to 
destination file>" 

To copy a folder: 

Engine.Shell.CopyDirectory "<source path>", "<destination path>" 

To add lines to the logfile "%WinDir%\SapSetup.Log" : 

Engine.Context.Log.Write "Customer-Scripting... " 
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In a similar manner, you can use the following:  

Engine.Shell.DeleteFile( sFile as String) as Boolean 

Engine.Shell.DeleteDirectory( sDir as String) as Boolean 

Engine.Shell.FileExist( sFile as String) as Boolean 

Engine.Shell.Execute( CmdLine as String, Async as Boolean) as variant 

Engine.Shell.ExecuteEx( CmdLine as String, Async as Boolean, Visible 
as Boolean) as Variant 

Engine.Shell.OpenDocument( file as String) as Boolean 

Engine.Shell.DeleteRegKey( keyPath as string) as Boolean 

Engine.Shell.DeleteRegValue( KeyAndValuePath as string) as Boolean 

Engine.Shell.GetRegValue(KeyAndValuePath as string) as Variant 

Engine.Shell.RegKeyExist( KeyPath as String) as Boolean 

Engine.Shell.RegValueExist( KeyAndValuePath as String) as Boolean 

Runtime Information 
In the script, the object Engine.Context can be used to obtain runtime information: 

Engine.Context.WkstaName as String gives the name of the client computers 

Engine.Context.UserId as String gives the username, under which the installation is 
executed 

Engine.Context.Win95 as Boolean has the value vbTrue, if Windows 95 is installed (in 
a similar manner, you can use the following: .Win98, .WinME, .WinNT, .Win2k, .WinXP, 
.WTSServer, .WTSClient) 

Example 
In this trivial example: 

• OnBeginInstall edits the registry. 

• OnEndInstall checks the existence of a file and, if found, opens it. It then displays a 
message box with information about the client computer.. 

• OnUninstall edits the registry to remove the keys that were created by the 
OnBeginInstall script. 

OnBeginInstall 

Engine.Shell.SetRegValue  "HKLM\Software\SAP\TestKeys\OnBeginInstall\DwordEntry", 
"REG_DWORD", "123" 

Engine.Shell.SetRegValue  "HKLM\Software\SAP\TestKeys\OnBeginInstall\StringEntry", 
"REG_SZ", "Hello World!" 

OnEndInstall 

If Engine.Shell.FileExist("C:\A_FRONTEND_SERVER\setup\sapadmin.chm") Then 

 Engine.Shell.OpenDocument "C:\A_FRONTEND_SERVER\setup\sapadmin.chm" 

End If 

Engine.MsgBox "Workstation Name: " & Engine.Context.WkstaName, vbInformation 
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OnUninstall 

If Engine.Shell.RegKeyExist("HKLM\Software\SAP\TestKeys") Then 

 Engine.Shell.DeleteRegKey "HKLM\Software\SAP\TestKeys" 

End If 
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6 Installing from a Server 
Prerequisites 
An installation server has been set up. 

Either the appropriate authorizations are available or the Distribution Service has been 
configured. 

Procedure 
... 

1. Map the shared directory, containing the installation files on the installation server, to a 
local drive. 

2. Start netsetup.exe from the root folder of the mapped drive. 

If a user is authorized to install several packages, a list of these packages is displayed. 

3. Select the components or packages to be installed, and choose Install. 
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6.1 Installing Packages Using the Logon Script 
Use 
Since the front-end software is normally installed on a large number of computers, SAPSetup 
allows you to automate this task as well as take advantage of SMS integration.  

By inserting a command line into the logon scripts of the computers on which the front-end 
software is to be installed, you can start a package installation each time the user logs on. 

Procedure 
Insert the following command line (both the path and either the package name or unique 
package identifier must be used): 
\\<server>\<shared folder>\setup\sapsetup.exe /p:“<package name>“  

or  
\\<server>\<shared folder>\setup\sapsetup.exe /p:“<unique package 
identifier>“ 

 
The unique package identifier is automatically generated when you create a 
package. It cannot be altered. Run SAPAdmin and select the package to see its 
unique package identifier. It is better to use the unique package identifier rather 
than the name, because the name need not be unique and can be changed. 

Starting this command line for the very first time on a computer, SAPSetup will install the 
specified package.  

Starting the same command line again on the next logon, SAPSetup checks whether the 
installed package is still up-to-date. If the installation server has been updated by a front-end 
patch since the last logon, SAPSetup will re-install the updated components. The front-end 
software (especially SAP GUI) should not be running at the same time because program files 
in use could cause a reboot.  

Additional Options 
See also Command Line Parameters [Page 42] for a list of options. 

The following two switches should be used only for problem cases – for example, if users 
have deleted parts of their installation manually but the installation information still shows that 
all components are correctly installed. 

Preventing SAPSetup from Running More than Once on Each PC 
The switch /once:”<name>” prevents SAPSetup from running more than once on a PC. If 
SAPSetup is started anew with the same parameter /once:”<name>” on that PC, 
SAPSetup terminates immediately. Therefore, if you want to use SAPSetup again for 
updating or performing a fresh installation, you need to change the value <name>, or delete 
the switch entirely.  <name> can be an arbitrary string. 

Switching Off the Version Check 
The switch /force disables the version check when copying files so that older versions are 
copied over newer ones (this does not apply to Microsoft system files). Additionally, it forces 
all existing installed components to be installed anew. 

In combination with the switch /once, /force forces a one-off complete reinstallation. 
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7 Upgrading the Front End 
Use 
Upgrading is the same as doing a new installation. 

Upgrading from Release 6.20 
The installation software updates the existing SAP Front End 6.20 to 6.40 without an 
uninstall. Although this is faster than uninstalling first, obsolete components might be left 
untouched. If you want a fresh installation, see Uninstalling the SAP Front End [Page 41]. 

Upgrading from Releases Between 4.5A and 6.10 Inclusive 
The installation software automatically uninstalls a preexisting SAP GUI for Windows of 
releases 4.5A to 610 inclusive. GUIs of earlier releases are unaffected. 

Upgrading from 4.X Releases Older than 4.5A 
You should run sapsweep.exe to uninstall releases of SAP GUI for Windows older than 
4.5A. 
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7.1 User-Specific Automatic Update 
Use 
If SAP GUI 6.40 is installed from an installation server, each user will have the option to 
enable automatic update from this server. Each time he or she double-clicks the SAP Logon 
(or SAP Logon Pad) icon, the automatic update will check the installation server to see if it 
has been updated since the last installation. If so, SAPSetup /update will be run before 
SAP Logon is started. This mechanism can be regarded as an alternative to the use of a 
logon script. 

Procedure 
... 

1. On the desktop or in the Start menu (Start → Programs → SAP Front End), right-click 
on the SAPlogon icon and choose Configure Auto Update. 

The following dialog box appears: 

 
By default, the automatic update is: 

• switched on if the installation of SAP GUI 6.40 was run from an installation 
server. 

• switched off if the installation of SAP GUI 6.40 was run from CD. 

2. Choose Apply to activate your selection. 
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8 Local Installation from CD 
Use 
To install front-end software components on a single computer. You can install directly from 
CD without setting up a front-end server. 

Prerequisites 
You need local administrator rights under Windows 2000 or Windows XP. 

Procedure 

Installing the SAP Front End 
... 

1. In folder Gui\Windows\Win32\SETUP in the substructure for Presentation CD1 on 
the NetWeaver Presentation DVD, start setup.exe.  

The setup wizard appears. 

2. Choose Next. 

3. Specify the target folder for the program files. The default is C:\Program 
Files\SAP\FrontEnd 

4. Choose Next.  

The setup wizard displays a hierarchical tree containing the components, and groups of 
components, you can select. 

5. Select the components you want to install. When you select a group or component, a 
short description with the disk space required is displayed on the right. A checked box 
is white if all the components underneath have been selected, but is gray if only some 
have been selected. 

6. Choose Next. 

7. Choose Install.  

The installation starts. If a restart is required, a dialog will appear. In this case choose 
OK. The reboot would only occur at the start of the installation process.

Changing the Configuration 
... 

1. Select ADD or Remove Programs from the Windows Control Panel. 

A list of installed applications appears. 

2. Choose SAP Front End from the list, and choose Change. 

The configuration wizard appears. 

3. Select Add or remove one or more SAP Front-End components, then choose Finish. 

4. Select or deselect the components that you want to add or remove respectively. 

5. Choose Install. 

Uninstalling the SAP Front End 
... 

1. Select ADD or Remove Programs from the Windows Control Panel. 

A list of installed applications appears. 

2. Choose SAP Front End from the list, and choose Change. 
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3. Select Uninstall and Finish. 

4. Confirm your decision in the dialog box that appears. 
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9 Patch Deployment 
Server-Based Patch Deployment 

Procedure 
... 

1. Download the patch from the SAP Service Marketplace at 
http://service.sap.com/patches 

2. Apply the patch to the installation server. See Applying Patches to Installation Servers. 

3. Distribute the patch to the clients. See Distributing Patches to Clients. 

Patch Application on Standalone Computers 
In this case, patches are applied to a PC or notebook without an installation server. The GUI 
must have been installed using a CD. See Applying Patches to Standalone Clients. 
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9.1 Applying Patches to Installation Servers 
Use 
Apply the patches to the server and, if used, update the Distribution Service. The patch level 
of the server can be displayed in SAPAdmin by choosing View → Server Monitor. 

 

Prerequisites 
You have downloaded the latest patches from the SAP Service Marketplace. 

Procedure 
... 

1. Start sapadmin.exe. 

2. Choose Server → Apply Patch/Update... 

3. Choose Browse to select the patch, then confirm your selection with Open. 

A list of files appears. 

 
4. Choose Install. 

5. If the Distribution Service (DS) is used, update it. Either start SAPAdmin and configure 
the DS (choose Server → Configure Services...), or  

... 
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a. Stop the service. You can use Services from the Administration Tools section of 
the Windows Control Panel to do this. 

b. Replace all .exe and .dll files of the DS, in folder the %windir%\SAPWksta 
(usually c:\winnt\sapwksta on Windows 2000, and 
c:\windows\sapwksta on Windows XP and Windows 2003 Serve) of the DS 
server, with the newer files from the Setup folder of the installation server. 

c. Restart the service. You can use Services from the Administration Tools section 
of the Windows Control Panel to do this. 
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9.2 Distributing Patches to Clients 
Prerequisites 
The installation server has had the latest patch applied. 

Procedure 

Manual Application of Patches 

Alternative 1. 
... 

1. In the Windows Control Panel on the client, Choose Add/Remove Programs. 

A list of installed applications appears. 

2. Choose SAP Front End from the list, and choose Change. 

3. Choose Change. 

4. Select Update: Keep SAP Front-End components up to date with the installation 
source. 

 
5. Choose Finish. 

This updates everything that is installed. 

Alternative 2. 
... 

1. In the Windows Control Panel on the client, Choose Add/Remove Programs. 

A list of installed applications appears. 

2. Choose SAP Front End from the list, and choose Change. 

3. Select Add or remove SAP Front-End components in the component selection wizard, 
then choose Finish 

The Configuration Wizard starts. Components that are obsolete are grayed out. 
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4. Select the grayed-out components. 

5. Choose Next. 

6. Choose Finish. 

This updates only the selected components. 

Automatic Application of Patches 
... 

1. Add the following command line to the logon script of the client: 
sapsetup /update 
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9.3 Applying Patches to Standalone Clients 
Prerequisites 
You have local administrator rights under Windows 2000 or Windows XP. 

Procedure 

Using the Control Panel 
... 

1. Select ADD or Remove Programs from the Windows Control Panel. 

A list of installed applications appears. 

2. Choose SAP Front End from the list, and choose Change. 

The configuration wizard appears. 

3. Select Apply a SAP Front-End patch (for stand-alone computers, e.g. laptops), then 
choose Finish. 

4. Select the patch that you want to apply. 

5. Choose Finish. 

Using the Command Line 

With user interaction 
... 

1. From the command line, run sapsetup /patch 

 
2. Choose the patch and then choose Open. 

3. Choose Finish. 

Without user interaction 
Either double-click the front end patch <path>\<patch>.exe, or run sapsetup 
/patch:"<path>\<patch>.exe" from the command line. 
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10 Checking the Installation 
Use 
This can be used for server-based installations or for standalone installations. You can save 
the results of the check in a file which can be used by SAP support.  

Procedure 
Call sapsetup.exe /check 
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10.1 Viewing the Log 
Use 
You can check the installation by viewing the log file sapsetup.log. The log file can be 
found in:  

• C:\WINDOWS\ under Windows XP 

• C:\WINNT\ under Windows 2000 

The most recent log has no number. The older logs are numbered. The higher the number, 
the older the log. Each time new log is generated, each of the log numbers is incremented by 
1. 

Procedure 
1. Run saplogvw.exe from the server, to start the SAPSetup Log Viewer. 

2. Enter the path and filename of the log file. 

3. Choose Finish. 

The log file is displayed. Errors are colored red. Warnings are colored blue. 

40 06.10.2005 



  SAP Front End Installation Guide 

11 Uninstalling the SAP Front End 
Procedure 
... 

1. In the Windows Control Panel, choose Add or Remove Programs. 

2. Select SAP Front End. 

3. Choose Remove. 

4. Select Uninstall all SAP Front-End Components. 

5. Choose Finish. 

If something is running that needs to be shut down, a dialog box appears. 

Result 
The SAP Front End is uninstalled and a log file generated. 
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12 Command Line Parameters 
You can call SAPsetup.exe with the parameters listed in the table below. 

SAPSetup Parameter Description 

/check[:"<file name>"] [/silent] Checks all the installed components. 

/config Starts the configuration wizard for adding 
or removing components and packages. 

/p:["<package name>"] 
[/uninstall] [/silent] 

Displays the wizard for choosing 
packages. 

/patch Only for a local installation from CD. Starts 
the wizard for selecting and applying a 
patch. 

/noDlg Shows only the progress dialog. Displays 
no other user interface. Can be used 
instead of /silent. 

/force Switches off the version check so that 
older versions can be copied over newer 
versions (this does not apply to Microsoft 
system files). 

/once:”<name>” This prevents SAPSetup from running 
more than once for a given parameter 
<name>. If SAPSetup is to be used again, 
change the value of <name> (or delete the 
switch /once completely). 

/server[:"\\<installation share 
folder>"] [/update] 

Applies the delta for a new compilation. 

/silent Displays no user interface – not even 
progress. 

/uninstall Uninstalls all components. 

/update Updates all components. 

You can call SAPAdmin.exe with the parameters listed in the table below. 

SAPAdmin Parameter Description 

/config Starts the configuration or installation of 
the DS. 

/patch[:"<gui patch>"] [/silent] Starts the wizard for selecting and 
applying a patch. 

/server:"\\<Server>\<Share>" Configures the specified installation 
server. 

By default, SAPAdmin configures the installation server from which it was started. The 
/server switch is also useful for applying setup patches that contain SAPAdmin or other 
setup binaries. SAPAdmin cannot be replaced on the installation server from which it is 
running. To solve this without requiring to restart the server, you can run SAPAdmin from a 
different location, for example the Presentation CD, and apply a setup patch on your 
installation server by using this command line : 
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<CD Drive>:\GUI\Windows\Win32\setup\sapadmin.exe 
/server:"\\<Server>\<Share>" 
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13 Component List 
The component list describes the features and functions of the selectable components, and 
the prerequisites for using them. The components are grouped under component groups. 

List of Component Groups 

Component Groups 

Group Description 

SAP GUI SAP GUI and related components. 

R/3 Add-On Front-end add-on for SAP R/3 Enterprise. 
This package contains application 
extensions needed for some R/3 
transactions. Ask your SAP system 
administrator for details. 

General Add-On Front-end add-on that can be used to 
extend functionality of SAP systems and 
that are not restricted to one SAP 
Component (R/3, BW, APO, CRM, SEM, 
KW, EP, ...) 

Development Tools Collection of Tools for Development. 

Legacy Components Components for use with older SAP 
releases (R/3 4.6 and lower) or old Office 
products (Excel 95, ...). These components 
will only be needed if you intend to use this 
version of SAP GUI for Windows with your 
old SAP installations. 

BW Add-On Front-end add-on for SAP NetWeaver 
Business Intelligence (BI). Release 
independent: Can be used in SAP BW 
3.0B, SAP BW 3.5, and SAP NetWeaver 
2004s. If used in SAP NetWeaver 2004s, 
only the SAP BW 3.5 capabilities are 
available. 

BI Add-On Front-end add-on for SAP NetWeaver 
Business Intelligence (BI). Can only be 
used in SAP NetWeaver 2004s. Requires 
.NET Framework Version 1.1 (v1.1.4322), 
(see SAP Note 877774). 

CRM Add-On Front-end add-on for SAP Customer 
Relationship Management (CRM). 

KW Add-On Front-end add-on for SAP's Knowledge 
Management solution that includes all SAP 
training courses and all SAP 
documentation. 

SCM Add-On Front-end add-on for of SAP Supply Chain 
Management (SCM). 

SEM Add-On Front-end add-on for SAP Strategic 
Enterprise Management (SEM). 
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The Forms Design Tool is no longer available with the current version of the SAP GUI CD. 
For more information, see SAP Note 801524. 

List of Available Components 

SAP GUI 

Component Description 

SAP GUI with SAP Logon  SAP graphical front end with starter 
application SAP Logon. The user can 
display and modify connection information 
for SAP systems using SAP Logon. 

SAP GUI with SAP Logon Pad SAP graphical front end with starter 
application SAP Logon Pad. The user can 
only display preconfigured connection 
information, for SAP systems, provided by 
the installation administrator. 

SAP GUI Scripting SAP GUI Scripting Interface. 

GUI XT GUI Extensions for client side customizing 
of SAP screens. 

Shortcut to SAPlpd Routing program for print output on 
Windows PCs. SAPlpd is addressed via a 
network connection or locally via SAP GUI. 
If used via network connection, PC must 
have a fixed IP address, and SAPlpd must 
be started manually before printing. 

Web Dynpro Client The Web Dynpro Client is a graphical user 
interface intended for displaying Web 
Dynpro applications. Since Web Dynpro is 
based on a new programming model it is 
not possible to use SAP GUI for Windows 
to display these applications. The 
integrated Web Dynpro Client provides a 
solution to this problem. 

As of SAP GUI for Windows 6.40 a beta 
version of the Web Dynpro Client (with 
certain restrictions and limitations) is 
shipped as part of SAP GUI. 

Active Components The Active Component Framework is 
needed to enable Active Components (like 
Applets, ActiveX, or external programs like 
MS-Office or OpenOffice) within the Web 
Dynpro.  

It requires Adobe Reader 6.0 or Adobe 
Acrobat 6.0. 

R/3 Add-On 

Component Description 
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EC-CS: Remote Data Entry   Module EC: Data input and validation of 
reported financial data without a connection 
to an SAP System. Requires MS Access 
97. 

FI-LC: Remote Data Entry   Module FI: Data input and validation of 
reported financial data without a connection 
to a SAP System. Requires MS Access 95 
or 97. 

Interactive Excel   Module FI or EC: Add-on to MS Excel for 
creating reports in Excel using data from 
FI-LC or EC-CS consolidation. Excel 
sheets can be filled with data from R/3 or 
the Remote Data Entry tools for FI-LC and 
EC-CS. It can be used for data entry into 
the FI-LC or EC-CS Remote Data Entry 
tool. Requires MS Excel 97. 

CA-CAD Interface   Module CA: CAD interface of the SAP 
System. 

EC-EIS: MS Word Link  

 

Module EC /Executive Information System: 
Transfer of report data to Microsoft Word. 
Requires MS Word 95, 97 or 2000. 

PD: MS Excel Link   Module PT/ Shift Planning: Allows to 
display the SAP duty roster data with 
Microsoft Excel. Requires MS Excel 5, 95, 
97 or 2000. 

PS: Export Interfaces   Module PS: Export of project data in the 
formats GRANEDA, MS Access and MPX. 
Requires Graneda, MS Project 4 or any 
other program that can read MS Access 7 
data. 

Solution Manager Controls These Controls are used by the SAP 
Solution Manager. They add new graphical 
formats like the visualization of your 
business processes or your system 
landscapes. 

EH&S WWI  Module EH&S: Windows Word Processor 
Integration. Report tool for mySAP PLM 
Environment, Health and Safety to 
generate reports such as material safety 
data sheets and labels. RTF Viewer 
required, Word 97, 2000 or XP 
recommended. 

General Add-On 

Component Description 
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Engineering Client Viewer Engineering Client Viewer enables you to 
view 2D and 3D files in the Document 
Management System. The following 2D and 
3D formats are supported: 907, bmp, c4, 
cgm, dgn, dwf, dwg, dxf, gif, hpgl, iges, jpeg, 
mdl, mds, mi, mlr, mpc, pcx, pict, png, ps, 
ras, rvf, tg4, tiff, tlc, triff, txt, jt, wrl, stl. The 
viewer provides functions such as 
Redlining/Markup, Comparing, Measurement, 
Stamps and Watermarks, Rotating, Zooming, 
Printing. Additionally, Dynamic Assembly 
Viewing and Cross Sectioning are supported 
for 3D files.  

SAP Console   SAP Console is a framework in which 
several software components work together 
enabling users to access and execute R/3 
transactions from character-based devices. 
The three main components involved are 
"SAP Console", "SAP Console 
Administrator" and "SAP Console I/O 
Engine". For Windows 2000 and Windows 
XP only. 

SAPphone Call Status Control   The SAPphone Call Status Control allows 
to raise events to inform the R/3 SAPphone 
softphone user interface about telephony 
call state changes. The control itself has no 
user interface. It must not be reused by 
other components beside SAPphone. For 
Windows 2000 and Windows XP only. 

SAPphone Server Tool to connect the SAP System to 
telephone systems and call centers. For 
Windows 2000 and Windows XP only. 

Microsoft Outlook Integration   Integrates SAPoffice and WebFlow with MS 
Outlook, allowing the Outlook client to view, 
manipulate, and navigate SAPoffice folders 
and messages and WebFlow work items. In 
addition this software enables the 
SAPoffice Calendar to synchronize with the 
MS Outlook calendar in both directions. 
Requires Microsoft Outlook 98 or higher. 

Calendar Synchronization for Microsoft 
Outlook 

Outlook Client extension for the 
synchronization of SAPoffice calendar with 
the Outlook calendar. Requires Microsoft 
Outlook 98 or higher.  

Graphical Distribution Network   Display and maintenance of a distribution 
network inside a corporation. 

Development Tools 

Component Description 

Graphical Screen Painter   Graphical editor for the ABAP Development 
Workbench Screen Painter. 
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SAPforms   SDK for programming SAP Business 
Workflow with Visual Basic forms, Microsoft 
Outlook forms, Lotus Notes forms, or Lotus 
Domino. 

SAPforms (Runtime)  Contains the functions needed to start 
workflows and process SAP Business 
Workflow work items using Visual Basic 
forms, Microsoft Outlook forms, or Lotus 
Notes forms. Must be installed locally. 

SAPforms (Design-time)  

 

Contains the functions to enable Visual 
Basic forms, Microsoft Outlook forms, and 
Lotus Notes forms to start workflows and 
process SAP Business Workflow work 
items. SAPforms (runtime) are included. 
Must be installed locally. 

SAPforms (Lotus Notes Server)  Contains the functions needed on a Lotus 
Domino server to develop and maintain 
Lotus Notes forms to start workflows and 
process SAP Business Workflow work 
items. SAPforms (design time) are 
included. Must be installed locally. 

Unicode RFC Libraries Unicode RFC Libraries for software 
developers. Supports Unicode and Non-
Unicode communication partners. 
Accessible from Visual Basic via COM 
Interface.  

Legacy Components 

Component Description 

MS Word Link via RFC Installation of Word connection for SAP R/3 
3.x, 4.0A and 4.0B. Requires MS Word 6, 
95, 97 or 2000. 

Report Writer: MS Excel Link   Import filter for MS Excel: converts a file 
exported by Report Writer in Excel format 
(RPW format) into an Excel spreadsheet. 
Works with Excel 95, 97 or 2000. Used with 
SAP back-end Releases 3.1 to 4.5 only. 

XXL List Viewer is no longer available with the current version of the SAP GUI CD. For more 
information, see SAP Note 526579. 

BW Add-On 

Component Description 

Business Explorer (SAP BW 3.x) Business Intelligence Suite of SAP BW 
3.0B / 3.5 that provides tools for analysis 
and reporting. 

OLE DB for OLAP Provider   Front-end add-on to enable OLE DB for 
OLAP clients to connect to SAP 
NetWeaver Business Intelligence (BI). 
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Merchandise and Assortment Planning Front-end add-on for 'SAP for Retail: SAP 
Merchandise and Assortment planning' that 
provides tools for planning. Requires 
Microsoft Excel 97 or 2000. 

BI Add-On 

Component Description 

Business Explorer (SAP NetWeaver2004s) Business Intelligence Suite of SAP 
NetWeaver that provides tools for analysis, 
reporting and planning. 

Pre-calculation Server Windows service that is required for pre-
calculating BEx Analyzer workbooks. 

 

CRM Add-On 

Component Description 

CRM Front End CRM front end. 

KW Add-On 

Component Description 

KW Knowledge Workbench Authoring Tool to easily maintain SAP 
documentation and SAP training. Requires 
Microsoft Internet Explorer 5 

KW Online Editing   Knowledge Warehouse Editing within SAP 
GUI. Requires Microsoft Internet Explorer 
5. 

KW Translator   Knowledge Warehouse Translator: 
Translation tool to process translation 
packages offline. Requires Microsoft 
Internet Explorer 5. 

PAW Author   Performance Assessment Workbench 
Author: Authoring Tool to easily maintain 
test items, performance units, performance 
tests and surveys. Contains "Knowledge 
Workbench" and "KW Translator". Requires 
Microsoft Internet Explorer 5. 

KW Viewer   Viewing tool to display training courses 
offline. 

SCM Add-On 

Component Description 

SCM Front End   SCM front end. 

SEM Add-On 

Component Description 

Balanced Scorecard   Balanced Scorecard Presentation. 
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Graphical Assignment   Graphical Assignment Tool. 

Sales Planning   Sales planning Add-In to MS Excel. 
Requires MS Office 97 or MS Office 2000. 
You can use this Add-In to extend your 
local MS Excel to enable Sales Planning 
within Excel environment as part of 
Customer Relationship Analytics.  
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14 Supplementary Notes 
BI Add-On 
The BI Add-On requires .NET Framework Version 1.1 (v1.1.4322), which can be 
found at: 

http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/dnnetdep/html/redistdeploy1_1.asp (the document is titled Redistributing the .NET 
Framework 1.1) 

The US-English version of the .NET Framework installer, dotnetfx.exe, can be found on 
the CD in the subfolder ...\Win32\System\DotNetv11. 

Installation can be done by double-click. 

A silent installation can be started with the command line using 

dotnetfx.exe /q:a /c:"install /l /q".  

If you distribute a SAP Front End package using an installation server, do the following (step 
1 is optional): 
... 

1. Add the .NET Framework 1.1 Language Pack LangPack.exe available from the 
above Microsoft website to the sub-directory on your installation server called local. 
To do this, create the sub-directory <Path to the Installationserver-
share>\System\DotNetv11\local\ and copy the file LangPack.exe to this sub-
directory. 

2. Use the command line: <Path to the Installationserver-
share>\Setup\SAPsetup.exe /p="$MS DotNetv11". 
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Part III SAP GUI for the Java Environment 
The installation instructions for SAP GUI for the Java environment are in chapter 4 of the 
document PlatinManual. The document can be downloaded from the SAP Service 
Marketplace in the Download Section of the SAP GUI for the Java environment pages: 

http://service.sap.com/sapgui-java
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